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1. ORDERING GUIDE

Configure a model number in this format: L5002, CBL01 

L......... .................... Serial input meter 
Includes screw terminal connectors. 

Processors & Display Color 

5 ......................................... Green LED 
6 ............................................. Red LED 

Power 

0 .  ................... 85-264 Vac, 90-300 Vdc 
1 ...  ..................... 10-48 Vdc, 12-30 Vac 

Setpoint Output 

0 ................................................... None 
1………………… Two 8A contact relays 
2............. Two 130 mA solid state relays 
3…………………Four 8A contact relays 
4.............Four 130 mA solid state relays 

Analog Output 

0 ................................................... None 
1 . Single 4-20 mA, 0-10 V, -10 to +10 V 
2 ......... Dual 4-20 mA, 0-20 mA, 0-10 V 

Digital Interface 

0 ....................................................... None 
1 ..................................................... RS232 
2 .......... RS485 with dual RJ11 connectors 
4 .......... RS485 with dual RJ45 connectors 
5 ........................................................ USB 
6 ........................ USB-to-RS485 converter 
7 .................................................. Ethernet 
8 .................. Ethernet-to-RS485 converter 

Options 

BL………… .... Blank lens, no button pads 

Accessories 

CBL01 ………  RJ11-to-DB9 RS232 cable 
  Connects meter to PC com port 

CBL02 ..... USB-to-DB9 adapter for CBL01 
CBL05 ............ USB cable to PC USB port 
CBL06 .. Half duplex RJ11 to PC USB port 
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3.  PRODUCT INTRODUCTION 

   
Our Serial Input Meter (or remote display) accepts serial data from scales, computers, 
programmable controllers, instruments or other devices to provide a six-digit numeric display 
from -999,999 to +999,999. It can also provide relay closures and one or two analog outputs 
based on the received serial data. Its appearance matches that of our 1/8 DIN digital panel 
meters, counters and timers.  

The Serial Input Meter is a 6-digit counter without a signal conditioner board, but with a com-
munications board, which is required. Choices are RS232, RS485, USB or Ethernet. With 
RS232, RS485 or USB, the received data can be continuous (or streaming), be in command 
mode using Laurel’s Custom ASCII protocol, or be in command mode using the Modbus RTU 
protocol. With Ethernet, the received data can only be in command mode using the Modbus 
TCP/IP protocol, which uses the same syntax as Modbus RTU. 

A Serial Input Meter can augment a Laureate meter or counter by displaying parameters that 
cannot be displayed on the single numeric display of that instrument. For example, a Laureate 
FR counter can only display rate A, rate B, ratio A/B or peak one at a time. By augmenting the 
counter with remote displays, all these parameters can be displayed simultaneously. The 
required user-selectable modes are provided for the sending counter and serial input meter.  

A single or dual channel analog output board is optional. Opto-isolation and 16-bit output 
resolution turn the Serial Input Meter into a low-cost and highly accurate isolated digital-to-
analog converter or transmitter. The dual analog output board uses the same digital input to 
provide two individually scalable analog outputs, such as 4-20 mA plus 0-10V. 

A 2- or 4-relay output board is optional and can add alarm or setpoint control capability. The 
relays can be 8A contact relays or 130 mA opto-isolated AC/DC solid state relays. The relays 
can respond to the transmitted values or to any of 8 serially transmitted control characters. The 
control characters can be generated by external software or by one of our meters, counters or 
timers, thereby assuring that the local and remote alarm points are identical. 

A standard switching power supply allows the Serial Input Meter to be powered worldwide 
from 85 to 264 Vac. An optional power supply operates from batteries or low voltage sources, 
such as 12-32 Vac or 10-48 Vdc.  

The meter case meets the 1/8 DIN size standard and is sealed to NEMA-4X (IP65) when 
panel mounted. Mounting is from the front of the panel and requires less than 110 mm behind 
the panel. All wiring is via removable plugs conforming to IEC950 safety standards. All output 
options are isolated from meter and power grounds to 250 Vac. 

Meter programming can be via the meter’s front panel or a PC running Windows based 
Instrument Setup (IS) software. 

A signal conditioner board is not required but will not interfere with remote display operation 
if installed. Operation as a remote display is selectable for our 6-digit counters with a signal 
conditioner, as explained in our separate Counter Manual. 
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4.  RECEIVING & UPACKING 

 
Your serial input meter was carefully tested and inspected prior to shipment. Should the meter 
be damaged in shipment, notify the freight carrier immediately. In the event the meter is not 
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or 
replacement.  Please include a detailed description of the problem. 

5.  SAFETY CONSIDERATIONS 

 
 

 Warning: Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of 
damage. If the unit is damaged, do not attempt to operate. 

Caution:  

 This meter must be powered with AC (mains) from 85-264 Vac (or 90-300 Vdc) with the 
high voltage power supply option, or 12-32 Vac (10-48 Vdc) with the low voltage power 
supply option. Verify that the proper power option is installed for the power to be used. This 
meter has no AC (mains) switch. It will be in operation as soon as power is connected. 

 The 85-264 Vac (or 90-300 Vdc) power connector (P1 Pins 1-3) is colored Green to 
differentiate it from other input and output connectors. The 12-32 Vac (10-48 Vdc) power 
connector is colored Black. 

 Do not make signal wiring changes or connections when power is applied to the meter. 
Make signal connections before power is applied. If reconnection is required, disconnect 
the AC (mains) power before such wiring is attempted.   

 To prevent electrical or fire hazard, do not expose the meter to excessive moisture. 

 Do not operate the meter in the presence of flammable gases or fumes, as such an envi-
ronment constitutes a safety hazard.   

 This meter is designed to be mounted in a metal panel. Verify the panel cutout dimensions, 
and mount according to instructions. 

 
Symbols used 
 

 
Caution (refer to accompanying documents) 

 
Earth (ground) terminal. 

 

 
Caution, risk of electric shock.  Both direct and alternating current. 

 
Equipment protected throughout by double 
insulation or reinforced insulation. 

  

 
Operating environment: 

The meter is Class II (double insulated) equipment designed for use in Pollution degree 2. 
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6.  CONNECTOR WIRING INFORMATION 

 
 
CONNECTORS 

Connectors for signal and power are U/L 
rated screw-clamp terminal blocks that 
plug into mating jacks on the printed 
circuit board. Communication connectors 
are a single RJ11 plug for RS232, dual 
RJ11 plugs for RS485, and dual RJ45 
plugs for RS485. 
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P3 - SERIAL COMMUNICATIONS   P4 - ANALOG OUTPUT 
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7.  MECHANICAL ASSEMBLY 

 
REMOVING THE REAR PANEL 

First remove any connectors. Use one hand to press in the two sides of the rear of the 
case, and the other hand to press down the two protruding tab releases at the top of the 
rear panel (see figure below). This will unhook the rear panel from the case. 

 

 
Rear Panel 

REMOVING THE ELECTRONICS & INSTALLING OPTION BOARDS 

With the rear panel removed, the 
electronic assembly will easily slide 
out through the rear of the case. 

Options boards plug into the main 
board at the front of the meter. 
These are plug-and-play and may 
be installed in the field. New 
boards will be recognized by the 
meter software for access to the 
appropriate menu items. You may 
need to remove rear panel knock-
outs to fit new boards.  

Note: When an option board is installed correctly, the top and bottom edges of the main 
board and option board are aligned. Misaligned boards will burn out the electronics. 

 

Option Board Rear Panel Jack 

Power supply (one required) 
Relay board (optional) 
Serial interface board (one required) 
Analog output board (optional) 
Signal conditioner board (not used) 

J1 
J2 
J3 
J4 
J5 

 
REASSEMBLING YOUR METER 

Slide the electronics assembly back into the case until the display board is seated flush 
against the front of the case. Insert the bottom tabs of the rear panel into the case, and then 
carefully align the board connectors with the openings in the rear panel. Ensure that all 
option boards are properly aligned with the molded board retaining pins on the inside of the 

Retaining tab 
with tab release 

Retaining tab
with tab release

Retaining tab
Retaining tab 
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rear panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal 
plugs. 
 

PANEL MOUNTING  

Slide the meter into the 45 x 92 mm 1/8 DIN panel cutout. 
Ensure that the provided gasket is in place between the 
front of the panel and the back of the meter bezel.  

The meter is secured by two pawls, each held by a screw. 
Turning a screw clockwise extends the pawl outward. 
Turning the screw clockwise further tightens it against the 
panel to secure the meter.  

Turning a screw counterclockwise loosens the pawl and 
retracts it into its well. This allows the meter to be inserted 
into the panel cutout for installation, or to be removed from  
the panel cutout following installation. 

Note: In no case should a screw be removed from its pawl. Doing so would cause the screw 
and pawl to fall off and likely get lost. 

 
 

 
 

Dimensioned case drawings 
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8.  FRONT PANEL SETUP KEYS 

 
 

 

Counter Front Panel 
 

There are four front panel keys, which change function for the Run Mode and Menu Mode, 
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU, 
PEAK, RESET, ALARMS) for the Run Mode and with symbols (  right arrow,  right 
triangle,  up triangle,   left arrow) for the Menu Mode. 

 
FRONT PANEL LOCKOUT 

The Menu Mode will not work with most meters shipped from the factory, since all menu 
items have been disabled in software and a lockout jumper is in place. This jumper needs to 
be removed for the Menu Mode to work, and values under _Loc 1 through _Loc 4 need to 
be set to "0" via the front panel for these menu items to be available. See Section 9. The 
paragraphs below assume that all lockout features have been removed. 

 
MENU MODE KEY ACTION 

In the Menu Mode, pressing a key momentarily advances to the next item. Holding down 
the key advances through multiple menu items for fast menu navigation. 

 
KEYS IN RUN MODE 

 
MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing 
MENU repeatedly will step the meter through the various menu items (if these have not 
been locked out) and then back to the Run Mode.    

RESET Key. Pressing RESET with ALARMS resets latched alarms. Pressing RESET 
with MENU performs a meter reset (same as power on).  
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ALARMS Key.  Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it 
again displays the setpoint for Alarm 2. Pressing it again returns to the present value. 
After 30 seconds, the meter automatically returns to the present value. Timing is 
automatically reset whenever the ALARMS key is pressed. 

 
KEYS IN MENU MODE 

 
Right Arrow Key (MENU).  Pressing  steps the meter through all menu items that 
have been enabled and then back to the Run Mode. If a change has been made to a 
menu item, that change is saved to non-volatile memory when the  key is pressed 
next, and _StoreE is displayed briefly.  

Right Triangle Key (Digit Select).  
Pressing  from most menus selections sequentially selects digit positions 1 - 6, as 
indicated by a flashing digit: 000000, 000000, 000000, 000000, 000000, 000000.  

Up Triangle Key (Value Select). Pressing  for a flashing digit position or decimal 
point position will increment that item. Pressing the MENU key will save any changes. 

Left Arrow Key (Reverse Menu).  Pressing  has the same effect as the MENU key, 
except that menu items are brought up in reverse order. 
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9.  ENABLING & LOCKING OUT MENU ITEMS 

 
For security reasons and ease of counter operation, any or all menu 
items can be disabled or "locked out" so that they are no longer 
accessible from the front panel. Each function to be disabled can be 
set to "1" under menu headers Loc 1-4, while each function to be 
enabled can be set to "0." Access to the menu headers Loc 1-4 can 
in turn be locked out by installing a hardware jumper on the power 
supply board. With the jumper installed, the operator only has 
access to previously enabled menu items, not to the menu headers 
Loc 1-4 and hence not to the menu items below. With the jumper 
removed, the operator has access to menu headers Loc 1-4 and 
hence to the menu items below. 

SETTING HARDWARE LOCKOUT JUMPER 

To access the lockout jumper, remove the rear panel per Section 9 
and locate jumper “a” in the lower portion of the power supply board 
next to the input connectors (see figure at right). 

SETTING SOFTWARE LOCKOUTS 

When setting up the meter, it may be neces-
sary to enable specific menu items by setting 
the corresponding lockout digit to 0. Be sure 
to reset the lockout digit to "1" if you do not 
want the menu item to be changed by an 
operator. 
 
_Loc 1   _Loc 2   _Loc 3   _Loc 4     

Press the  MENU key until Loc 1, Loc 2, 
Loc 3 or Loc 4 is displayed, as desired. Note: 
the lockout jumper must be removed (see 
above). 
 
111111 

Press  to display the lockout status, con-
sisting of 0’s and 1’s. The left digit will flash. 
Press  again to step to the next digit, which 
will flash. 
  
000000 
123456 

Press  to set the flashing digit to "0" to 
enable the menu item or to "1" to disable. 
Press MENU to enter. See the table to the 
right for list of menu items that can be 
enabled or disabled. 

Enabled / Disabled Menu Items 

_Loc 1 

3 - Input type selection 
4 - Setup, Config, Dspyno 
5 - Gate time, timeout, batch setup 
6 - Filter setup 

_Loc 2   

3 - Slope, decimal points 
4 - Scale, offset, resolution, 2-coord.  
5 - Alarm setup 
6 - Alarm setpoint programming 

_Loc 3    

3 - Analog output setup & scaling  
4 - Serial communications configuration 
5 - Calibration 
6 - Change displayed Item # 

_Loc 4    

3 - View peak value  
4 - View alarm setpoints 
5 - Front panel resets (peak & latched 
 alarms) 
6 - Front panel reset (cold reset only) 
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10.  SERIAL COMMUNICATION BOARD SETUP 

 
A serial communications board is required for serial input meter / remote display operation. 
Available boards are RS232, RS485, USB, and Ethernet. 

To program the remote display using the USB port of a PC running Instrument Setup (IS) 
software, set the remote display to 9600 baud and use the Custom ASCII protocol. You will 
also need to select a COM port, since all serial communications with the remote display use a 
UART. To find the COM port assigned by the PC, you can use trial and error or use Device 
Manager under the Windows Control Panel. After executing the last Put command, which 
downloads setup data from the PC into the remote display, exit IS software, disconnect your 
PC, and connect to the device which is sending the data to be displayed. 

 If the remote display has a USB board, use a USB cable with Type A and Type B 
connectors. The PC will recognize the FTDI chip on the USB and automatically install the 
driver for it. You will need to select a COM port. 

 If the remoted display has an RS232 board, use Laurel cables CBL01 and CBL02, which 
plug into each other. The PC will recognize the FTDI chip in the CBL02 adapter cable and 
automatically install the driver for it. You will need to select a COM port. 

 If the remoted display has an L485 half-duplex RS485 board, use Laurel cables CBL06. 
The PC will recognize the FTDI chip in the CBL06 adapter cable and automatically install 
the driver for it. You will need to select a COM port. 

 If the remoted display has an LNET Ethernet board, use an Ethernet cable with RJ45 
connectors to plug the remote display into the same LAN as the PC. Use IS software to 
discover the Ethernet Node and the Device attached to that Node, with is the remote 
display. Then use the Main Menu of IS software to program the remote display. 

For operation as a remote display: 

 If the remote display has a USB board, connect that board to the sending PC with a USB 
cable with Type A and Type B connectors. The display can receive streaming serial data, 
Custom ASCII protocol commands, or Modbus RTU commands, as programmed. 

 If the remote display has an RS232 board and is a slave to a Laureate meter or counter 
with a streaming RS232 output, install jumper f on the RS232 board of the slave meter, not 
the sending meter. Use a reversing phone cable, where the wire colors of the two 
connectors are reversed from left to right. Use 9600 baud. See the Serial Communications 
Options section of this manual or the Jumper Settings sections of our Custom ASCII 
Protocol Serial Communications Manual. The display can receive streaming serial data, 
Custom ASCII protocol commands, or Modbus RTU commands, as programmed. 

 If the remote display has an RS232 board and is a slave to another instrument with a 
streaming RS232 output, install jumper f on the RS232 board of the slave meter. Make 
sure that RX goes to TX, and TX goes to RX. The display can receive streaming serial 
data, Custom ASCII protocol commands, or Modbus RTU commands, as programmed. 

 If the remote display has an Ethernet board and is on the same LAN as a Modbus 
Master, it will act a Modbus Slave and respond to Modbus TCP commands as described in 
this manual and our separate Modbus Communications Manual for Counters.  
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COMMUNICATIONS BOARD SETUP VIA JUMPERS 

 Ethernet Board** 
 or USB Board 

     No jumpers needed 

  

 RS232 Board 

e -  Do not install for remote display.. 
f -  Install for remote display operation. 

     g - Install for normal meter operation. 

Note:  Board is shipped with jumper g installed.  

 RS485 Board, Full Duplex Operation * 

b & d - Installed on last meter in long cable run. 

 RS485 Board, Half Duplex * 

a & c - Installed for half duplex operation. 
d - Installed on last meter in line with long cable runs.  

 RS485-Modbus Board, Full Duplex Operation * 

b & e - Bias jumpers should be installed on 1 board. 
a & d - Installed on last meter in long cable run. 

 RS485-Modbus Board, Half Duplex Operation * 

b & e - bias jumpers installed on 1 board. 
c & f - installed for half duplex operation. 
a - installed on last meter in line with long cable runs. 

Modbus

ba

cd
e

RJ45

RJ45

f

 

 Ethernet-to-RS485 Converter Board** 
 & USB-to-RS485 Converter Board 

 Full Duplex Operation 

No jumpers for short cable runs. 
Add b & d for long cable runs. 

 Half Duplex Operation 

a + c for short cable runs. 
Add d for long cable runs. 

 

    

 *  Board shipped with no jumpers installed. 

 ** For Ethernet Node discovery and setup, refer to our separate Ethernet manual, which 
explains our Node Manager software and the Web Page built into each Node. In Node 
Manager software, click on the Advanced tab, and set “Parent Meter Interrogation” to 
“Disabled”. In the Web Page under “Device Interface Setup”, set “Stop interrogating meter 
continuously” to “Yes.” Otherwise the Ethernet card will try in vain to fetch readings from 
the parent meter and reset the meter. 
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11.  SERIAL INPUT METER / REMOTE DISPLAY CONFIGURATION  

 
Two operation modes are available: 1) continuous (or streaming) serial data input, and  
2) command mode.  

 For the continuous mode, the sending device (such as a panel meter or weighing scale), 
must have an automatically repeating data output. The format of that output must be known 
in advance, as provided by the manufacturer of the sending device or as determined by the 
user with a terminal emulator program like PuTTY. The continuous mode is supported by 
RS232, RS485 and USB, not Ethernet. 

Instrument Setup (IS) software, which runs on a PC, is required to select from a choice of 
continuous operating modes and to set up parameters for the Remote C operating mode, 
as detailed in this manual. The Remote C mode can extract readings from long ASCII text 
strings. It can accommodate selected Start and Stop characters, mask OFF any number of 
characters between the Start character and the start of data, mask ON up to 8 display 
characters (including sign and decimal point), and ignore characters between the last 
displayed character and the Stop character. 

 For the command mode, the sending device must send specific commands to the remote 
display to write to a variable (or memory location) called Item #3. That variable is then 
displayed by the meter and can also be used for alarm comparisons and for analog output. 
With RS232, RS485, commands can use the Custom ASCII protocol, as documented in 
Laurel’s Custom ASCII Protocol Serial Communications Manual, or the Modbus protocol, 
as documented in Laurel’s Modbus Counter Manual. Our RS232, RS485 and USB boards 
support the Custom ASCII and Modbus protocols. Our Ethernet boards only support the 
Modbus protocol. That protocol was specified international to only works in command 
mode, not continuous mode. 

Use the meter front panel to set up communication parameters. Two items require special 
explanation: 

 For the Custom ASCII Protocol, the first digit under ConFig is set to a value 6 thru C. 
Since no signal conditioner board is detected, the meter defaults to setting 6, where H, L, K 
commands are enabled. H means display the remote data only. K means that the received 
value is stored as Item #3, to become the source for alarm comparisons and analog output. 
L means both H and K. In slave mode (8, 9, A, B), the remote meter can display any item 
of up to four data Items (or string values), such as the Sum of Rates A & B (Item #1), Rate 
A (Item #2), or Rate B (Item #3). 

 For the Modbus protocol, the first digit under ConFig is forced to be a 6, where H, L, K 
commands are enabled. 

 A timeout ti-Out can be set to a value from 10 ms to 199.99 sec. This is how long a serial 
reading will be displayed in the absence of a new serial input. If timeout is set to 0, the 
display will persist indefinitely in the absence of a new input. 

Additional programmable features of the serial input meter are detailed in the “Command 
Mode for Remote Display Operation of Counter / Timer” and “Data Formats” sections of our 
Custom ASCII Protocol Serial Communications Manual.  
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SELECTED FRONT PANEL SETUP ITEMS FOR SERIAL INPUT METER (not consecutive) 

For the complete list of front panel setup items, see Section 10 of our separate COUNTER / 
TIMER / SERIAL INPUT METER OWNERS MANUAL. 

If the MENU    key does not work, see Section 9 “Enabling & Locking Out Menu Items.” 
 

  

Press 
Menu 

   

Press Digit 
Select Key 

   

Press Value Select 
Key 

 

SEtuP  
Setup 

_000_0 
Control inputs 1 and 2 

F  1 = Tare Enable,  2 = Tare 
      Control input 2 must be at 0V or grounded for 
     Tare to operate. 

ConFiG 
Configu-
ration 

__0000   Display mode 

Notes: Remote modes  
S (selection 7) and C  
(selection C) are used  
for most applications. 
Modbus uses selection 6 
only. 

6   Remote display (H, K, L commands) 
7   Single-value remote display 
8   Show 1st string value, connected to a counter 
9   Show 2nd string value, connected to a counter 
A   Show 3rd string value, connected to a counter 
B   Show 4th string value, connected to a counter 
C   Custom Start, Stop, Skip, Show characters 

.ti_Out. 
Time-out 

_000.00 _000.00 _000.00 

_000.00 _000.00  
Select digit to flash. 

Select 0 thru 9 for flashing digit to set time-out in 
seconds. Decimal point location is fixed for 10 ms 
resolution. This is how long a serial reading will be 
displayed in the absence of a new serial input.  
Enter 0 so that the display persists indefinitely in  
the absence of a new input. 

.SEr 1. 
 

__000UBaud rate 

Fixed parameters: 

No parity, 8 data bits, 

1 stop bit 

0   300 baud  1   600 baud 

2   1200 baud 3   2400 baud 

4   4800 baud  5   9600 baud  

6   19200 baud 

.SEr 2. __0000UMeter address Select 0 thru F for addresses 1 thru 15. Select 0. thru 

F. (with decimal point) for addresses 16 thru 31. 

Address 0 is accepted by all meters. Do not use with 

Modbus. 

.SEr 3. _00000URS485 0   Full duplex 1   Half duplex 

 SEr 4. ___000USerial protocol 0   Custom ASCII 1   Modbus RTU 

2   Modbus ASCII 

___000UParity 0   None 1   Odd 2   Even 

_Addr 
 

___000 __000 ___000 

Modbus address 
__158   Select 0 through 9 for flashing digit. Address 

range is 1 to 247. 
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 12.  REMOTE DISPLAY OF LAUREATE METER OR COUNTER 

 

1. OVERVIEW 

If the remote display is to show the continuous RS232 or RS485 readings of a Laureate 
meter of counter device as the sender, setup is most easily accomplished from the front 
panel of both devices, without use of Instrument Setup (IS) software. The example below is 
for a process meter as the sender and a remote display as the receiver. Connection is via 
Laurel’s CBL03 data cable using half duplex RS485 (data interface ordering code 2, 
interface board P/N L485). The CBL03 data cable is non-reversing and has RJ11 con-
nectors on both ends. Communications use the Custom ASCII protocol which supports a 
continuous data output, unlike the Modbus protocol. Standard Custom ASCII communi-
cations are at 9600 baud, N81. 

2. SENDING PROCESS METER 

 Set SEr1 to 151. This sets signal to filtered, baud rate to 9600, and data output every 
0.28 sec. The latter is the meter display update rate when filtering is set for 60 Hz noise 
rejection. 

 Set SEr2 to 0001. This specified no line feed after carriage return, no alarm data, conti-
nuous data output, and address 1. 

 Set SEr3 to 10000. This specifies half duplex, standard continuous mode, normal RTS, 
termination character only at end of all items, and sending of meter reading. 

 Set SEt4 to 000. The first 0 specifies a Modbus gap timeout, which does not apply. The 
second 0 specifies the Custom ASCII protocol, which is critical for continuous data 
output. The third 0 specifies no parity, as required for the Custom ASCII protocol. 

3. RECEIVING REMOTE DISPAY 

 Set ConFiG to 7. This selects single-value remote display. 

 Set ti Out to 001.00. This specifies that the reading will be held for 0.01 sec in the 
absence of a new serial data input. 

 Set SEr1 to 050. The digit 5 specifies 9600 baud. 

 Set SEr2 to 0001. The digit 1 sets the device address to 1. 

 Set SEr3 to 10000. The digit 1 specifies half-duplex RS485. 

 Set SEr4 to 000. The middle digit 0 specifies the Custom ASCII protocol. 
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13.  INSTRUMENT SETUP VIA PC 

 

1. OVERVIEW 

If the sending device is a non-Laurate device, use Laurel’s free Instrument Setup (IS) 
software for additional flexibility. IS software runs on a PC and provides a graphical user 
interface. The software allows uploading, editing, downloading and saving of setup data, 
and execution of commands under computer control.  

4. Connection to PC 

 RS232. To connect a Remote Display with an RS232 interface and an RJ11 connector 
(board P/N L232) to the USB port of a PC, use Laurel cables CBL01 and CBL02, which 
plug into each other. CBL02 contains an FTDI RS23-to-USB converter chip, which is 
compatible with all versions of Windows. 

 RS232. To connect a Remote Display with an RS232 interface and an RJ11 connector 
(board P/N L232) to the RS232 port of a PC, use Laurel cable CBL01. 

 Half-duplex RS485. To connect a Remote Display with a half-duplex RS485 interface 
and dual RJ11 connectors (board P/N L485) to the USB port of a PC, use Laurel cable 
CBL06. That cable contains an RS485-to-USB converter chip, which is compatible with 
all versions of Windows.  

 USB. To connect a Remote Display with a USB interface and an RJ45 connector (board 
P/N LUSB) to the USB port of a PC, use Laurel cable CBL05. This is a common USB 
cable with Type A and B connectors. 

After the Remote Display has been programmed using IS software, it can be disconnected 
from the PC and be connected to the data streaming source (if other than the PC). 

5. IS Software Installation & Launch 

As a first step, set User Account Control (UAC) of your version of Windows to "Never notify" so 

that IS software can create directories. Use Google for instructions. Power down and restart 

your computer for the UAC change to take effect. Download the file IS3_5_4.exe from our 

website and double-click on the file name. Click on “Install Instrument Setup Software” and 

follow the prompts. To launch IS software, press on Start => Programs => IS2 => Instrument 

Setup or on the desktop icon that you may have created. Following a brief splash screen, the 

Communications Setup screen below will appear. 

To launch IS software, press on Start => Programs => IS2 => Instrument Setup or on the 
desktop icon that you may have created. Following a brief splash screen, the Commu-
nications Setup screen will appear. 
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In the Communications Setup screen above, select the Custom ASCII as the protocol 
and Panel Meter as the Device Type. Then click on the RS232 button, which also serves for 
USB and half-duplex RS485. This will take you to the Establish Communications screen 
below. 
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In the Establish Communications screen, select your Com Port and 9600 as the Baud 

Rate. Try different Com ports until one works, or use the Windows Device Manager to read 

your Com port and change it if desired. Click on Establish, and the two fields at the bottom of 

the screen should turn green. Click on Main Menu. The computer will remember your commu-

nication settings for the next time that you run IS software.  

From the Main Menu, click on Counter => Get Setup to retrieve (or get) the existing setup 
data from your remote display. Click on View => Setup to bring up screens which allow you 
to easily edit the setup file using pull-down menus and other selection tools. You can 
download (or put) your edited file into the transmitter by clicking on Counter => Put Setup. 
You can save your setup file to disk by clicking on File => Save Setup and retrieve a 
previously saved file from disk by click on File => Open. 

 

Click on Counter => Get Setup to retrieve the current setup information from your counter, 
then on View => Setup, which will take you to the Input+Display tab. Use this screen to set 
up Display Type, Control Inputs and Time Out. 

For Time Out, enter the number of seconds that a serial reading will be displayed in the 
absence of a new serial input, after which ti-Out will be displayed. If timeout is set to 000.00, 
the display will persist indefinitely in the absence of a new input. 

For Display Type, select one of the following:   

Rmt Dsply A = Addressable remote display mode for string *#LSDDDD.DDA<CR><LF>, 
where * is the recognition character, # is the address, L is a command character which can 
be H, K or L, S is sign (space or + for positive, - for negative), D is a digit from 0 to 9, A is an 
optional alarm character which overrides internal alarm comparisons, <CR> is the carriage 
return character, and <LF> is an optional line-feed character, which is ignored.  The follow-
ing Remote Display data types are user selectable: 
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Rmt Dsply S = Single value, non-addressable remote display for SDDDD.DDA<CR> <LF>, 
where S is sign (space or + for positive, - for negative), A is an optional alarm character 
which overrides internal alarm comparisons, <CR> is the carriage return character, and 
<LF> is an optional line-feed character, which is ignored. 

Rmt Dsply 1 = 1st value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD 

Rmt Dsply 2 = 2nd value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD 

Rmt Dsply 3 = 3rd value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD 

Rmt Dsply 4 = 4th value of value sequence SDDDD.DDSDDDD.DDSDDDD.DDSDDDD.DD 

Data sequences with up to three data values can be generated by our digital panel meters 
(current reading, Peak, Valley). Data sequences with up to four data values can be gene-
rated by our counters (Items 1, 2, 3, Peak). Please refer to our DPM and counter manuals. 

Rmt Dsply C = Masked remote display. Allows data extraction from a long string as speci-
fied under the Communication tab. The required data entry fields will only appear under the 
Communication tab if Display Type has been specified as Rmt Dsply C under the 
Input+Scaling tab. Works only with the Custom ASCII protocol, not the Modbus protocol, 
since a meter cannot listen to commands while in the Rmt Dsply C display type. For more 
information on Rmt Dsply C, see the manual section for the Communication tab. 

Executing a Main Menu > Counter > Put Setup command downloads the setup information 
into the meter, including the Rmt Dsply C display mode if selected.  

Warning: Do not execute a Main Menu > Counter > Get Setup command if you have placed 
the remote display into the Rmt Dsply C mode, since normal meter communications cannot 
occur in that mode. Our Instrument Setup Software will then reset the remote display to Rmt 
Dsply A. 

Warning: Do not execute a Main Menu > Counter > Get Setup command if you have placed 
the sending meter or transmitter into the continuous mode, since IS software uses the 
command mode and will reset the sending unit to command mode. 

For more information on serial communications, please download our Series 2 Serial Com-
munications Manual (for Custom ASCII Protocol) and our Series 2 Modbus Communications 
Manual (for Modbus Protocol). 

For Control Inputs, select the desired action of grounding Control Input 1, Control Input 2, 
and both Control Inputs 1 and 2.  

 Meter Reset is a master reset like removing and reapplying power.  

 Function Reset resets latched alarms. 

 Alarm Active allows external control of relays, as opposed to using normal setpoint 
operation.  

 Display Blanking blanks the meter display. 

 Enable Tare enables a meter tare function and enters the current reading as a value to 
be subtracted as a tare value. 

 Tare if Enabled subtracts the tare value from the current reading. 

Ignore the following selections, which do not apply to remote display operation: Peak, 
Valley, External Gate, Meter Hold, Total A Reset, Total B Reset.  
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You can also define a Custom Recognition Character in lieu of the default *.  

Ignore Output Items, Output Filter, Output Rate, CR (LF), RTS Type, Include Alarm Data, 
Include LF, and Transmission Chars. These items only apply to data transmission by a 
counter, not to operation as a remote display. 

For the Custom ASCII Protocol only, the Remote Display “C” data entry fields will appear if 
you have selected Rmt Disply C under the Input+Display tab to allow data extraction from a 
longer data string. You can specify:  

 Start Char = the decimal ASCII character designating the beginning of a string. 

 Stop Char = the decimal ASCII character designating the end of the string. 

 Skip No. = the decimal number of characters following the Start Char to be ignored. 

 Show No. = the decimal number of characters immediately following the ignored 
characters to be displayed. 

Example: *ABCD-123.45EFG#HIJK* etc. 

Start = *, Skip = 4, Show = 7, Stop = #, data displayed = -123.45 

For the list of 127 possible ASCII start and stop characters and the corresponding decimal 
values to be entered, click on ASCII Char Table. 

Click on the Communication tab  
to view the communication parame-
ters that you used initially. You can 
reselect Baud Rate, Device Address, 
Serial Protocol, Full/Half Duplex,  
even though you may have selected 
different values to establish initial 
communications with your PC.  
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Click on the Relay Alarms tab to set up your meter’s two or four optional relays. The same 
digital source is used for all relays and must be set to Item 3 under Alarm Source. A 
separate Setpoint and a Hysteresis band or Deviation band can be set up for each relay. 
The relays will respond to your digital entries without decimal point.  

For help with any selectable item, select that item with your cursor and press the F1 key. 
This will bring up a help window like the one shown. 

 Alarm Type. Selections are Non-Latching and Latching. Under Non-Latching, the relay is 

only closed (or open) while the Alarm State is Active. Under Latching, the activated relay 

remains closed (or opens) until reset regardless of the Alarm State. Resetting is normally 

achieved by temporarily grounding one of the transmitter’s control inputs, which has been 

set to Function Reset under the “Input+Display” tab. 

 Alarms 1,2 No. Rdgs to Alarm. Selections are binary steps from 1 to 128. This is the 

number of consecutive alarm readings that must occur to create an Active alarm. Numbers 

higher than 2 provide some Alarm filtering so that 1 or 2 noisy readings do not cause an 

Active Alarm. The Alarm becomes Inactive if one of the consecutive readings fails to be an 

Alarm reading. The Alarm readings counter then resets to 0. 
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Click on the Analog Out tab to scale your meter’s optional single or dual analog outputs. 
Item 3 must be selected as the Analog Output Source. With dual analog outputs, that same 
digital source will be used for both outputs, but the outputs can be scaled independently of 
each other. For each output, select 0-20 mA Current, 0-10V Voltage, or 4-20 mA under 
Range. Enter the Lo Range Reading which will correspond to the bottom of your analog 
output (such as 4 mA). Enter the Hi Range Reading which will correspond to the top of your 
analog output (such as 20 mA). The analog output will then be interpolated between these 
two endpoints. The low and high readings will be interpreted without decimal point. For help 
with any selectable item, select that item and press the F1 key. 

JUMPER PULL-DOWN MENU 

The Jumpers pull-down menu shows jumper positions for selected plug-in boards. 
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14.  COMMAND MODE WITH CUSTOM ASCII PROTOCOL 

 

Laurel’s Custom ASCII protocol allows the Remote Display to receive data in the form of 
ASCII text strings, which can be either in a streaming Continuous Mode or in a Command 
Mode, as described in the manual at https://www.laurels.com/downloadfiles/serialcom2.pdf.  

To set up the Remote Display for Command Mode using the Custom ASCII Protocol, use IS 
software as described in a previous section of this manual. Select the Custom ASCII 
Protocol and Command Mode. Select the Analog Out type as 4-20 mA, 0-10 mA, 0-10V or -
10V to +10V. Enter the Lo Range and Hi Range numerical readings which will serve as 
endpoints for the selected output type. Set the “Source” value to Item 3, which will be used 
for analog output interpolations and for relay setpoint comparisons. 

Example on how to output 12 mA:  

For setup: 

1. Set the “Source” value to Item 3. 

2. Set the Analog Out type to 4-20 mA.  

3. Set the Lo Range Reading to 0 counts. 

4. Set the Hi Range Reading is 10000 counts. 

For normal operation, send *1H005000<CR><LF> 

Recognition character: * 

Address character: 1 

Command character: H 

Value: 005000 

Verify the analog output with a panel meter or multimeter. 
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15. COMMAND MODE WITH MODBUS RTU PROTOCOL 

 
Laurel’s implementation of the Modbus RTU protocol allows the Remote Display to receive 
data in the form of Modbus commands. As for the customer ASCII Protocol in Command 
Mode, these are used to write values to a variable called “Item 3”, which will be used for 
analog output interpolations and for relay setpoint comparisons for relay action. Modbus 
commands are also available to overwrite setup parameters entered with IS Software “on 
the fly,” including the following: 

1. Change scale and offset or coordinates of 2 points parameters to generate the analog 
output derived from Item 3. 

2. Change setpoints to control relay action derived from Item 3. 

3. Force relay action regardless of Item 3 

4. Reset latched alarms by forcing a Function Reset. 

See Modbus the manual at https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf 
for a Modbus RTU overview and for all available Modbus commands for Counters, not just 
those for the Remote Display. In particular, see the long section entitled, “FC03 (READ) & 
FC10 (WRITE) HOLDING REGISTER ADDRESSES.” Use Hi Word starting Register 
Addresses and an even number of Registers. The Register Addresses shown in this section 
apply to both FC03 and FC10. They are for Modbus numbering systems that start at 00 01 
(Base 1). Subtract 1 from each Register Address for Modbus numbering systems that start 
at 00 00 (Base 0). 

To write values to Item 3 with Base 1 addressing, write the Hi Word applied to Item 3 to hex 
register address 006C, and the Lo Word applied to Item3 to hex register address 006D. With 
Base 0 addressing, the Hi Word address becomes 006B, and the Lo Word address 
becomes 006C. The qModMaster example on the next page illustrates how to use Base 0 
addressing to generate 4, 12 and 20 mA analog outputs.    

Example on how to send the value 999999 to Item #3 of a Remote Display using the 
Modbus protocol: 

1 10 00 6B 00 02 04 00 0F 42 3F F4 87 

Address: 01 
Function Code: FC10 
Holding Register: 006C 
Number of Registers Sent: 0002 
Number of Bytes Sent: 04 
Register Data: 000F 423F (999999 in decimal) 
CRC: F487 
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16.  USING DIAGNOSTIC TOOL QMODMASTER 

1.  ABOUT QMODMASTER 

qModMaster.exe is a freeware Windows program which allows a PC to serve as a Modbus 
Master. It is an easy-to-use tool to verify communications, send requests to Modbus 
Slaves, and view their responses. qModMaster works well with Base 0, but not with Base 1, 
so use it only with Base 0 and subtract 1 from the Register addresses listed in our Modbus 
Manual for Counters. For more information, see the qModMaster section of our Modbus 
Manual for Counters at https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf.  

Download qModMaster from SourceForge at: 
https://sourceforge.net/projects/qmodmaster/files/latest/download 

Click on the downloaded file and install it in a directory of your choice. Create a desktop 
icon from the installed executable. Before using qModMaster, ensure that your Remote 
Display has been set to Modbus RTU as explained in the Instrument Setup (IS) software 
section of this manual. 

2.  EXAMPLE: USE MODBUS COMMANDS TO OUTPUT 4, 12 OR 20 mA 

The task is to configure qModMaster to generate analog outputs of 4, 12 and 20 mA. This 
assumes that Instrument Setup (IS) software has already been used to set up the analog 
output as 4-20 mA with an Item 3 Lo Range Reading (for 0 mA) of +000000 and an Item 3 
Hi Range Reading (for 20 mA) of +010000. These decimal values of 0, 5000 and 10000 
form 32 bit hex values of 0000 0000, 0000 1388 and 0000 2710. 

Launch qModMaster. A screen of the type shown below will appears. Under View, press 
Bus Monitor. Under Options, make the selections illustrated below. The entered serial port 
should be the number assigned by Windows Device Manager.  

 

 

 

Note that that the entry in counts to be sent to Item 3 can be in Hex or Dec formats. Under 
Commands, press Connect to make the data connection. The Bus Monitor should show Tx 
and Rx “values written correctly.” For information on these values, please see our Modbus 
Manual for Counters at https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf.  
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The screen captures below are for Modbus TCP, but the syntax is the same for Modbus 
RTU. An external panel meter or multimeter connected to the analog output should show 
the desired output currents. 
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3.  EXAMPLE: USE MODBUS COMMANDS TO CONTROL TWO RELAYS 

Using BASE 0 addressing, alarm relays are controlled by writing to holding register 0x006F.  
Bit 0 controls Relay 1. Bit 1 controls Relay 2. 

First Alarm1 is forced by writing 01 to holding register 0x006. This turns Relay1 on. 

Then Alarm2 is forced by writing 03 to holding register 0x006. This turns Relay2 on. 

Both relays are turned off by writing 00 to holding register 0x006. The setup for this last 
command is seen in the qModMaster window. 

The Bus Monitor window displays the result of all three write commands. 
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17.  DUAL & QUAD RELAY OUTPUT OPTIONS 

 
An optional relay board may be installed in the 
meter main board at plug position P2, adjacent 
to the power supply board. Four board versions 
are available: 2 or 4 relays, contact or solid state. 
Once installed, the relay board is recognized by 
the meter software or PC-based Instrument Set-
up software, which will bring up the appropriate 
menu items for the type of board. These menu 
items will not be brought up if a relay board is not 
detected. Menu selections for relays 3 and 4 will 
not be brought up if the dual relay board is detected. All relay boards offer a choice of 
operating modes: normally off or on, latched or non-latched, hysteresis band, deviation band, 
alarm based on filtered or unfiltered signal, and selectable number of readings in alarm zone 
for alarm. The source compared to the setpoint may be the displayed item or a non-displayed 
item. Please see the Glossary at the end of this manual for an explanation of special terms.  

VIEWING & CHANGING SETPOINTS 

The  (Alarms) key can be used to step through and view setpoints while the meter conti-
nues to make conversions and performs setpoint control. If the  (Peak) key is pressed while 
a setpoint is displayed, conversion stops and the setpoint can be changed. After pressing , 
you have 30 seconds, or the meter reverts to the normal display. To view setpoints, menu item 
Loc4, digit 4, must have been set to 0. To change setpoints, menu item Loc2, digit 6, must 
have been set to 0.  

  

Press Alarms  
Key 

 
  

Press Digit 
Select Key 

 
  

Press Value Select  
Key 

 

3950.00 
Press  (Alarms)  
to display Alarm 1 
setpoint. 

3950.00 
Current setpoint 1 value blinks, and 
Alarm 1 LED indicator lights. Press 

 to select a digit, which will blink. 

3050.00 
To change setpoint 1 value, 
press  to change selected 
blinking digits. 

3950.00 
Press  (Alarms)  
to display Alarm 2 
setpoint.  

3950.00 
Current setpoint 2 value blinks, and 
Alarm 2 LED indicator lights. Press 

 to select a digit, which will blink. 

3050.00 
To change setpoint 2 value, 
press  to change selected 
blinking digits. 

3950.00 
Press  (Alarms)  
to display Alarm 3 
setpoint.  

3950.00 
Current setpoint 3 value blinks, and 
Alarm 3 LED indicator lights. Press 

 to select a digit, which will blink. 

3050.00 
To change setpoint 3 value, 
press  to change selected 
blinking digits. 

3950.00 
Press  (Alarms)  
to display Alarm 4 
setpoint.  

3950.00 
Current setpoint 4 value blinks, and 
Alarm 4 LED indicator lights. Press 

 to select a digit, which will blink. 

3050.00 
To change setpoint 4 value, 
press  to change selected 
blinking digits. 

3000.24   Press  (Alarms) again. Meter will reset and display the current reading. 
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KEYSTROKES FOR SETUP  
If the MENU    key does not work, see Section 9 “Enabling & Locking Out Menu Items.” 
 

  

Press 
Menu 

 
  

Press Digit 
Select Key 

 
  

Press Value Select 
Key 

 

SourcE 
Source to com-
pare to setpoint 

    0000   Setpoint 1: 3   Must be set to Item #3. 

    0000   Setpoint 2: 3   Must be set to Item #3. 

    0000   Setpoint 3: 3   Must be set to Item #3. 

    0000   Setpoint 4: 3   Must be set to Item #3. 

AL SEt 
Alarm Setup 
for relays 1 & 2 
if detected. 

Press  until 
ALSEt is 
displayed. 

  00000 
Relay state when alarm is 
active 

0   Relay 1 on Relay 2 on 
1   Relay 1 off Relay 2 on 
2   Relay 1 on  Relay 2 off  
3   Relay 1 off  Relay 2 off 

  00000 
Alarm latching or non-
latching (auto reset) 
(see Glossary) 

0   AL1 auto reset  AL2 auto reset 
1   AL1 latching   AL2 auto reset  
2   AL1 auto reset  AL2 latching  
3   AL1 latching  AL2 latching 

  00000 
Alarm operates at and 
above setpoint (active 
high) or at and below 
setpoint (active low). 
(see Glossary) 

0   AL1 active high  AL2 active high 
1   AL1 active low  AL2 active high 
2   AL1 disabled  AL2 active high 
3   AL1 active high  AL2 active low 
4   AL1 active low  AL2 active low 
5   AL1 disabled  AL2active low 
6   AL1 active high  AL2 disabled 
7   AL1 active low  AL2 disabled 
8   AL1 disabled  AL2 disabled 

  00000 
Hysteresis mode or band 
deviation mode 
(see Glossary) 

0   AL1 band deviation AL2 band deviation 
1   AL1 hysteresis  AL2 band deviation 
2   AL1 band deviation AL2 hysteresis 
3   AL1 hysteresis  AL2 hysteresis 
4   No deviation or hysteresis on menu. 

  00000 
Number of consecutive 
readings in alarm zone to 
cause an alarm 

0   After 1 reading  4   After 16 readings 
1   After 2 readings  5   After 32 readings 
2   After 4 readings  6   After 64 readings 
3   After 8 readings  7   After 128 readings 
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Press 
Menu 

 
  

Press Digit 
Select Key 

 
  

Press Value Select 
Key 

 

ALS 34 
Alarm Setup 
for relays 3 & 4 
if detected. 

  00000 
Relay state when alarm is 
active. 

0   Relay 3 on Relay 4 on 
1   Relay 3 off Relay 4 on 
2   Relay 3 on  Relay 4 off  
3   Relay 3 off  Relay 4 off 

  00000 
Alarm latching or non-
latching (auto reset). 
(see Glossary) 

0   Alarm 3 auto reset Alarm 4 auto reset 
1   Alarm 3 latching   Alarm 4 auto reset  
2   Alarm 3 auto reset Alarm 4 latching  
3   Alarm 3 latching   Alarm 4 latching 

  00000 
Alarm operates at and 
above setpoint (active 
high) or at and below 
setpoint (active low). 
(see Glossary) 

0   AL3 active high  AL4 active high 
1   AL3 active low  AL4 active high 
2   AL3 disabled  AL4 active high 
3   AL3 active high  AL4 active low 
4   AL3 active low  AL4 active low 
5   AL3 disabled  AL4 active low 
6   AL3 active high  AL4 disabled 
7   AL3 active low  AL4 disabled 
8   AL3 disabled  AL4 disabled 

  00000 
Hysteresis mode or band 
deviation mode 
(see Glossary) 

0   AL3 band deviation AL4 band deviation 
1   AL3 hysteresis  AL4 band deviation 
2   AL3 band deviation AL4 hysteresis 
3   AL3 hysteresis  AL4 hysteresis 

  00000 
Number of consecutive 
readings in alarm zone to 
cause an alarm. 

0   One reading in the alarm zone will cause  
an alarm. This entry is ignored by remote 
display. Enter any number, such as 0. 

 

 

  

Press 
Menu 

 
  

Press Digit 
Select Key 

 
  

Press Value Select 
Key 

 

dEUn1H Alarm 1 hysteresis 0.00000 0.00000 0.00000 

0.00000 0.00000 0.00000 

Select digit to flash 

Select -9 thru 9 for flashing 
first digit, 0 thru 9 for other 
flashing digits. Alarms will 
activate above the setpoint  
by the value entered and  
deactivate below the setpoint  
by the value entered. See 
Glossary. 

DEUn2H Alarm 2 hysteresis 

DEUn1b Alarm 1 band deviation 

DEUn2b Alarm 2 band deviation 

dEUn3H Alarm 3 hysteresis 

DEUn4H Alarm 4 hysteresis 

DEUn3b Alarm 3 band deviation 

DEUn4b Alarm 4 band deviation 
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18.  SINGLE & DUAL ANALOG OUTPUT OPTIONS 

 
Two versions of an analog board may be installed in the meter at rear panel jack position J4, 
adjacent to the signal conditioner board. Once installed, this board is recognized by the meter, 
which will bring up the appropriate menu items for it. These will not be brought up if an analog 
output board is not installed. 

A single analog output version can be configured for unipolar 4-20 mA current, 0-20 mA 
current or 0-10V voltage, or bipolar -10 to +10V voltage (with a 20V voltage swing). Unipolar or 
bipolar operation is selected by a jumper. 

A dual analog output version can be configured for two unipolar outputs, which can each be 
4-20 mA, 0-20 mA or 0-10V. Current or voltage output is selected at each connector. 

 
 

Unipolar current or voltage: Jumper a 
Bipolar -10 to +10 voltage:   Jumper b 

No jumpers, only selections at the connectors. 

With either board, current or voltage output is selected at the connector and in the Menu. The 
low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low displayed 
reading _An_Lo. The high analog output (20 mA, 0V or 10V) may be set to correspond to any 
high displayed reading _An_Hi. The meter will then apply a straight line fit between these two 
end points to provide an analog output scaled to the meter reading. The decimal point location 
is fixed by the dEC.Pt1 selection. 

 

The analog output is sourcing. Do not put an external voltage source in series with 
it. Applying an external 24 Vdc source will burn out the analog output board. 

 
 
KEYSTROKES FOR SETUP OF SINGLE ANALOG OUTPUT BOARD 
If the MENU    key does not work, see Section 9 “Enabling & Locking Out Menu Items.” 

  

Press Menu 
Key 

 

  

Press Digit Select 
Key 

 

  

Press Value Select 
Key 

 

An_SEt 
Analog Output Setup. 
Press  until AnSEt is 
displayed. 

         00 
Calibration output 
selection. 

0   0-20 mA current output 
1   0-10V voltage output 
2   4-20 mA current output 
3   -10V to+10V voltage output 

         03 
Analog output source. 

3   Must be set to Item #3. 
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_An_Lo 
Low displayed value for 
-10V, 0V, 0 mA, or 4 mA 

0.00000 0.00000 0.00000 

0.00000 0.00000 0.00000 

Select digit to flash  

Select 0 thru 9 for flashing digit. 

_An_Hi. 
High displayed value for 
10V or 20 mA output 

0.00000 0.00000 0.00000 

0.00000 0.00000 0.00000 

Select digit to flash 

Select 0 thru 9 for flashing digit. 

 

KEYSTROKES FOR SETUP OF DUAL ANALOG OUTPUT BOARD 
If the MENU    key does not work, see Section 9 “Enabling & Locking Out Menu Items.” 

  

Press Menu 
Key 

 
  

Press Digit Select 
Key 

 
  

Press Value Select 
Key 

 

An_SEt 
Analog Output Setup. 
Press  until AnSEt is 
displayed. 

     0000 
Scaling of analog output 2  

0   0-20 mA current output 
1   0-10V voltage output 
2   4-20 mA current output 

    0000 
Source of analog output 2 

3   Must be set to Item #3. 

    0000 
Scaling of analog output 1  

0   0-20 mA current output 
1   0-10V voltage output 
2   4-20 mA current output 

    0000 
Source of analog output 1 

3   Must be set to Item #3. 

  An_Lo1 
Low displayed value for 
0V, 0 mA, or 4 mA output 

0.00000 0.00000 0.00000 

0.00000 0.00000 0.00000 

Select digit to flash 

Select 0 thru 9 for flashing digit. 

  An_Hi1 
High displayed value for 
10V or 20 mA output 

0.00000 0.00000 0.00000 

0.00000 0.00000 0.00000 

Select digit to flash 

Select 0 thru 9 for flashing digit. 
dEC.Pt1 selection. 

  An_Lo2 
Low displayed value for 
0V, 0 mA, or 4 mA output 

0.00000 0.00000 0.00000 

0.00000 0.00000 0.00000 

Select digit to flash 

Select 0 thru 9 for flashing digit. 

  An_Hi2 
High displayed value for 
10V or 20 mA output 

0.00000 0.00000 0.00000 

0.00000 0.00000 0.00000 

Select digit to flash 

Select 0 thru 9 for flashing digit. 
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19.  SPECIFICATIONS   

 
DISPLAY 

Type ................................................ 6 LED digits, 7-segment, 14.2mm, plus 4 LED indicators 
Digit Color ........................................................................................................... Red or green 
Display Range ..........................................................................................-999999 to +999999 

 
POWER REQUIREMENTS 

Input Voltage rating (standard) ....................................................... 85-264 Vac or 90-300 Vdc 
Input Voltage rating (low voltage option) ............................................ 12-32 Vac or 10-48 Vdc 
Power Line Frequency ................................................................................. DC and 47-63 Hz 
Power Consumption, Max ........................................................................................... 4 Watts 
 

DUAL OR QUAD RELAY OPTIONS 

Power to relay option ................................................................................... Powered by meter 
Setpoint setup ....................................................... Via front panel pushbuttons or RS232/485 
Response time .................................................................................... Serial input update rate 
Actuation Modes (selectable) ...... Above or below setpoint, latching or non-latching, disabled 
Front Panel Enable / Lockout Modes (selectable) ................. 1) Display and change setpoints 
 ................................................................................... 2)  Display but do not change setpoints 
 .................................................................................. 3)  Neither display nor change setpoints 
Alarm Status Indication .......................................................................... 2 or 4 red LED lamps 
Status Indication Setup (selectable) .......................................... Lit when output is ON or OFF 

Form C, SPDT Relay Output: 

AC Rating ......................................................................................................... 8A @ 240 Vac  
DC Rating ........................................................................................................... 8A @ 24 Vdc 
Isolation rating between signal common and contacts ............................................... 250 Vac 
Insulation dielectric strength between signal common and contacts ........................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 

Form A, SPST Solid State Relay Output: 

AC Rating .................................................................................................. 130 mA @ 140 Vac 
DC Rating .................................................................................................. 130 mA @ 180 Vdc 
Isolation rating between signal common and contacts ............................................... 250V ac 
Insulation dielectric strength between signal common and contacts ........................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 

 
ANALOG OUTPUT OPTIONS 

Power to Analog Output Option ................................................................... Powered by meter 
Output Levels, Single Analog Output Option ...............0-20 mA, 4-20 mA, 0-10V, -10 to +10V 
Output Levels, Dual Analog Output Option ..................................... 0-20 mA, 4-20 mA, 0-10V 
Voltage Compliance, 0-20 mA Output .................................................. 12V (0-600 Ohm load) 
Current Compliance, 0-10V Output ........................................... 2 mA (5 kOhm or higher load) 
Accuracy ............................................................................ ±0.01% of full scale analog output 
Resolution ........................................................................................... 16 bit (1 part in 65,536) 
Response Time ................................................................................... Serial input update rate 
Scaling of Reading for Zero Output ........................................................-999,999 to +999,999 
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Scaling of Reading for Full Scale Output ...............................................  -999,999 to +999,999 
Isolation rating between signal common and analog output ....................................... 250V ac 
Insulation dielectric strength between signal common and analog output ................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 

SERIAL INTERFACE OPTIONS 

Output Types ................................................................ RS232, RS485, RS485-Modbus, USB 
 .......................................... USB-to-RS485 converter, Ethernet, Ethernet-to-RS485 converter 
Power to Interface Option ............................................................................ Powered by meter 
RS485 Wiring ............................................................................................... Half or full duplex 
Baud Rates ............................................................ 300, 600, 1200, 2400, 4800, 9600, 19200 
Serial Protocols ............................. Custom ASCII, Modbus RTU, Modbus ASCII (selectable) 
Signal Levels ................................................. Meet RS232, RS485, USB, Ethernet standards 
Isolation rating between signal common and serial I/O .............................................. 250V ac 
Insulation dielectric strength between signal common and serial I/O .......................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 
Option Board Connectors: 
     RS232 (com option 1)  ............................................................................. Single RJ11 jack 
     RS485 (com option 2) ........... Two RJ11 jacks (for daisy chaining with 6-wire data cables) 
     RS485 (com option 4) ........... Two RJ45 jacks (for daisy chaining with 8-wire data cables) 
     USB (com option 5) .................................................................................. USB type B plug 
     USB-to-RS485 converter (com option 6) ....USB type B plug plus RJ11 jack to RS485 bus 
     Ethernet (com option 7) ................................................................. Single RJ45 to Ethernet 
     Ethernet-to-RS485 converter (opt 8) .. RJ45 jack to Ethernet plus RJ11 jack to RS485 bus 

ENVIRONMENTAL 

Operating Temperature ......................................................................................... 0°C to 55°C 
Storage Temperature ........................................................................................ -40°C to 85°C 
Relative Humidity ...................................................... 95% from 0°C to 40°C, non-condensing 
Case ............................ NEMA-4X (IP65) from front when panel mounted (not verified for UL) 
Shock ........................................................................... 10 G at 1 kHz, applied in X, Y, Z axes 
Vibration ............................................. 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.  
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20.  GLOSSARY OF TERMS 

 
Alarm, latched: An alarm which stays actuated until reset. Latched alarms can shut down 

machinery or a process when an operating limit has been exceeded, or maintain an 
alarm condition until acknowledged by an operator. 

Alarm, non-latched: An alarm which changes state automatically when the reading rises 
above a specified limit and changes back automatically when the reading falls below a 
limit. 

Custom ASCII protocol: A simplified protocol for use with panel meters, counters and timers. 
It allows 31 digital addresses. Not an industry-standard protocol, like the more complex 
Modbus protocol. 

Deviation band: A band in counts which controls relay action symmetrically around a setpoint. 
The relay actuates when the reading falls within the deviation band, and de-actuates 
when the reading falls outside of this band. A deviation limit (e.g., 50 counts) is set up 
around both sides of the setpoint to create a deviation band (e.g., 100 counts). Setting 
up a passband around a setpoint is often used for component testing. Deviation limits 
are programmed by entering menu item dEUn1b for Alarm 1 and dEUn2b for Alarm 2.  

Function reset: A rear panel input or keystroke action which resets any latched alarms.  

Hysteresis band: A band in counts which controls relay action symmetrically around a 
setpoint. The relay closes (or opens) when the reading goes above the setpoint plus 
one hysteresis limit, and opens (or closes) when the reading falls below the setpoint 
less one hysteresis limit. A narrow hysteresis band is often used to minimize relay 
chatter around a setpoint due to electrical noise or signal feedback caused by load 
switching. A wide hysteresis band can be used for control applications. 

 Item #: A numerical value generate by a counter and available for display or data output via 
serial communications. For example, in the A+B totalizer mode, the sum of A+B is Item 
#1, Total A is Item #2, and Total B is Item #3. Each item can be displayed by a Remote 
Display if the appropriate Display Type is selected under the Input+Display tab. 

Meter Reset: A rear panel input or front panel keystroke action which resets the meter like  

Half duplex: RS485 serial communications implemented with two wires, allowing data trans-
mission in both directions, but not simultaneously. 

Full duplex: RS485 serial communications implemented with four wires, allowing data trans-
mission in two directions simultaneously. 

Setpoint: A value compared to the reading to determine the state of a relay. Term often used 
interchangeably with “alarm setpoint.”  

Time-out: How long a serial reading will be displayed in the absence of a new serial input. If 
timeout is set to 0, the display will persist indefinitely in the absence of a new input. 
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21. WARRANTY

Laurel Electronics Inc. warrants its products against defects in materials or workmanship for 
a period of one year from the date of purchase.   

In the event of a defect during the warranty period, the defective unit may be returned to the 
seller, which may be Laurel or a Laurel distributor. The seller may then repair or replace the 
defective unit at its option. In the event of such a return, freight charges from the buyer shall 
be paid by the buyer, and freight charges from the seller shall be paid by the seller. 

LIMITATION OF WARRANTY 

The foregoing warranty shall not apply to defects resulting from: 

1. Improper installation or miswiring.
2. Improper or inadequate maintenance.
3. Unauthorized modification or misuse.
4. Operation outside the environmental specifications.
5. Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is 
expressed or implied. Laurel specifically disclaims implied warranties of merchantability and 
fitness for a particular purpose. 

Any electronic product may fail or malfunction over time. To minimize risks associated with 
reliance on Laurel products, users are expected to provide adequate system-level design 
and operating safeguards. Laurel’s products are intended for general purpose industrial or 
laboratory use. They are not intended nor certified for use in life-critical medical, nuclear, or 
aerospace applications, or for use in hazardous locations. 

EXCLUSIVE REMEDIES 

The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall 
Laurel be liable for direct, indirect, incidental or consequential damages (including loss of 
profits) whether based on contract, tort, or any other legal theory. 

Copyright 1999-2021, Laurel Electronics, LLC  Rev 17 December 2021 


